Operating Instructions
– Advanced MCACC PC Display Application Software –
About this manual

These are the Operating Instructions for an application which displays on your computer screen the listening room reverberation frequency characteristics and the MCACC parameters measured by the Advanced MCACC function of your VSX-03TXH, VSX-01TXH or VSX-9130TXH. It explains everything you need to know to use the application, from installation to troubleshooting. You will need to operate the receiver to use this application, so please refer also to the Operating Instructions supplied with the receiver.

About the Advanced MCACC Application

The functions of the Advanced MCACC application are used with the same purpose as the “Reverb View” functions of the receiver itself (see page 46 (VSX-03TXH)/45 (VSX-01TXH, VSX-9130TXH) of the receiver's Operating Instructions), namely to display the reverberation characteristics of the listening environment. Using a computer provides cleaner, more easily readable graphs. The application can also be used to display the measurement values stored in the receiver's MCACC memory.

Requirements for using the application on your PC

- Operating system must be Microsoft® Windows® XP (Service Pack 2) or Windows® 2000.
- CPU must be at least Pentium 3 / 300 MHz or AMD K6 / 300 MHz (or equivalent) with at least 128 MB of memory, and your monitor must be able to display a minimum resolution of 800x600.
- An RS-232C port connector is necessary for graphical output. Refer to the PC’s operating instructions and/or the PC manufacturer for more information on making the proper port settings.

Microsoft, Windows XP and Windows 2000 are registered trademarks or trademarks of the Microsoft Corporation of the United States and other countries.

Main features of the application

1. Displays 3D graphs of the reverberation frequency characteristics of your room. You can choose to see these measurements both with and without the equalization performed by this receiver (before and after calibration).
2. Allows you to display a list of the Advanced MCACC parameters (the results of measurements).
3. Allows you to view graphs in a number of different formats.
4. Allows you to save the various measured data on the computer.
5. Allows you to make memos about the conditions in your room when you made the measurements, etc.
6. Allows you to print the various graphs and the MCACC measurement values.
Things you can accomplish with this application

1. Advanced EQ Setup, which you can do with the receiver (see page 46 (VSX-03TXH)/45 (VSX-01TXH, VSX-9130TXH) of the receiver’s Operating Instructions), allows you to choose the optimum time period for auto EQ setup. You can use this application’s reverberation characteristics (Reverb) as a guide in choosing the best time period for your room.
   For details, see *How to Interpret the Graphs (page 18)*.

2. Skewed reverb frequency characteristics in your listening room can prevent you from enjoying an accurate sound field. The graphs displayed by this application are a powerful tool because they allow you to check these reverb frequency characteristics at a glance. You can also check the effectiveness of steps that you take to improve the acoustics of your listening room, for example, installing sound absorbent material.
   For details, see *How to Interpret the Graphs (page 18)*.

3. The MCACC parameter display (Parameters) allows you to display on the computer all the parameters (measurement values) stored in the receiver’s MCACC memories.
   For details, see *Display of the MCACC parameters (page 25)*.
Installing the Application

Install this application on your PC by using the downloaded installer. You will find the installer in the folder that you specified when you downloaded the application. If a previous version of the Advanced MCACC application (“Ver. 1.1”, “Ver. 1.4” or “Ver. 2.0”) is installed on your computer, please update the application. For details, see Updating the application (page 26).

1 Double click the “PioneerAdvancedMCACC_e_ver_*_*_*.exe” file.
The number after “ver” in the filename is the version number of the installer. Depending on the current configuration of your PC, the InstallShield Wizard can take some time to appear.

2 Click “Next”.

3 (If you agree to the contents of the License Agreement), select “I accept the terms in the license agreement”, then select “Next”.

Troubleshooting

If an error occurs when you double click and you are unable to proceed with the installation.
4 Input the Customer Information, then select “Next”.

5 Click “Next”.

The application is installed in the folder indicated at “Destination Folder”. The destination folder can be changed by clicking “Change...”.

Continue
6 Choose “Install”.

A shortcut icon is created on the desktop.

7 Click “Finish”.

The installation is complete.
Operations on the Receiver and Cable Connections

Connect the receiver and the computer in order to display on the computer the various data measured on the receiver itself.

1. Connect the receiver to your PC with a RS-232C cable.

**Caution**

Before making or changing connections, switch off the power and disconnect the power cord from the power outlet. Plugging in components should be the last connection you make with your system.

**Note**

- When using a notebook computer or other computer without an RS-232C terminal, this application can be used by connecting the receiver via USB using a commercially available USB-RS-232C conversion cable (USB-Serial cable). When using USB connections, be sure to select the proper COM port number for data transmission (see page 9).
- The type of cable to use is a female-female cross cable. Different manufacturers use different names to refer to this type of cable. Sometimes it is called an “interlink” cable, and sometimes it is called a “reverse” cable.

**Pin-out diagram of RS-232C cable to connect receiver and PC**

<table>
<thead>
<tr>
<th>Pin 1</th>
<th>Pin 2</th>
<th>Pin 3</th>
<th>Pin 4</th>
<th>Pin 5</th>
<th>Pin 6</th>
<th>Pin 7</th>
<th>Pin 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>2</td>
<td>3</td>
<td>3</td>
<td>4</td>
<td>4</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>7</td>
<td>7</td>
<td>8</td>
<td>8</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Dsub 9-pin female

- The following cable has been proved to ensure system operation.

<table>
<thead>
<tr>
<th>Brand</th>
<th>Cable</th>
<th>Part NO.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Belkin</td>
<td>Pro Series Serial Direct Cable-10 feet</td>
<td>F3B207-10</td>
</tr>
</tbody>
</table>
2 Perform the “Auto MCACC (ALL)” operation on the receiver. (See page 10 of the receiver’s Operating Instructions.)
   The setting here is not required if the “Auto MCACC (ALL)” operation has already been performed before connecting the RS-232C cable. Proceed to step 3.

3 From the receiver’s “Manual MCACC” menu, select “EQ Professional”, then select “Reverb Measurement” to measure the room’s reverb characteristics. (See page 46 (VSX-03TXH)/45 (VSX-01TXH, VSX-9130TXH) of the receiver’s Operating Instructions.)
   If you want to measure the room's reverb characteristics, select “EQ OFF”, then select “START”.
   If you want to measure the room's reverb characteristics after equalization, first perform the “Auto MCACC (ALL)” operation, then select “EQ ON”, then “START”. (See page 23.)
   **Note**
   Measure the room’s reverb characteristics after equalization with the microphone at the same position as when the “Auto MCACC (ALL)” operation was performed. The measurements are performed with the EQ values stored in the MCACC memory selected on the receiver, so before measuring the reverb characteristics, select the MCACC memory to be measured after equalization.

4 Select “Output PC” from “Data Management”.
   The message “Start the MCACC application on your PC” appears and the receiver enters transmission standby mode. It is ready to send data to your PC.
   This completes the preparations for sending the measurement data to your PC. (To send the data, proceed to the next section Application Operations.)
Applications Operations

This section explains operations that you do in the application, from receiving measurement data to displaying graphs and saving the data.

Receiving measurement data

1 Double click the application shortcut icon on the PC desktop.
   You can also start the application by selecting “Program” → “Pioneer Corporation” → “Advanced MCACC” from the “Start” menu.
   The application starts.

2 Select “Receive” under “File” on the menu bar.

3 Select the number of the COM port to which the RS-232C cable is connected.
   If you do not know which COM port number to select, try selecting each port in turn, beginning with “COM1”.

   ![COM port selection box]

   **Note**
   Refer the operating instructions of your PC for more information about COM port settings.

Troubleshooting

If an error occurs when you select “Receive” and no data is sent.
4 Select the type of data to be received, then select “OK”.  
Select “Reverb” to receive the data for the room’s reverb characteristics, and “MCACC Parameters” to receive the data for the various MCACC parameters (measurements results). The “Group Delay” function is not used on this receiver. Nothing happens if it is selected.

![Type of data selection](image)

Data transmission starts.

![Data transmission](image)

When reception finishes the received data appear.

**Note**
- The data used to display the reverberation characteristics graph (Reverb) is deleted when the receiver is turned off. In this case, no reverberation characteristics graph is displayed even if data is received. If you have turned the power off after taking the measurements, take the measurements over again.
- The data used to display the MCACC parameters is not deleted even when the receiver’s power is turned off.
- In order to avoid malfunction, after the completion of the data transmission, unplug the RS-232C cable connecting your PC and the receiver.
Graph and parameter displays (names and functions of parts)
When measurement data is received, the graphs and parameters display window appears. The display window is divided into two items, “Reverb” and “MCACC Parameters”. Select the desired tab to switch to that window and display the respective details. The “Group Delay” function is not used on this receiver. Nothing is displayed if “Group Delay” tab is selected. Also, on the Reverb graph display, Surround L and Surround R (SL and SR) are displayed as “Surround L A” and “Surround R A” (“SL A” and “SR A”).

Reverb (graph of the room’s reverberation frequency characteristics)
You can switch the display between individual displays for the different channels/frequencies or a list display of all the channels/frequencies (ALL). Below we explain the different parts of the individual displays and the ALL display, using the channel display as an example.

Individual display (Example: Left channel)

ALL display
**MCACC Parameters (list display of MCACC parameters)**

A list of the measurements in all the MCACC memories is displayed. It is also possible to display the measurements in the individual MCACC memories.

![McACC Parameters](Image)

<table>
<thead>
<tr>
<th>Speaker Distance</th>
<th>M1</th>
<th>M2</th>
<th>M3</th>
<th>M4</th>
<th>M5</th>
<th>M6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>8'06&quot;</td>
<td>8'06&quot;</td>
<td>8'06&quot;</td>
<td>8'06&quot;</td>
<td>8'06&quot;</td>
<td>8'06&quot;</td>
</tr>
<tr>
<td>Center</td>
<td>8'06&quot;</td>
<td>8'06&quot;</td>
<td>8'06&quot;</td>
<td>8'06&quot;</td>
<td>8'06&quot;</td>
<td>8'06&quot;</td>
</tr>
<tr>
<td>Right</td>
<td>8'02&quot;</td>
<td>8'02&quot;</td>
<td>8'02&quot;</td>
<td>8'02&quot;</td>
<td>8'02&quot;</td>
<td>8'02&quot;</td>
</tr>
<tr>
<td>Surround R</td>
<td>9'04&quot;</td>
<td>9'04&quot;</td>
<td>9'04&quot;</td>
<td>9'04&quot;</td>
<td>9'04&quot;</td>
<td>9'04&quot;</td>
</tr>
<tr>
<td>Surround L</td>
<td>7'10&quot;</td>
<td>7'10&quot;</td>
<td>7'10&quot;</td>
<td>7'10&quot;</td>
<td>7'10&quot;</td>
<td>7'10&quot;</td>
</tr>
<tr>
<td>Sub Woofer</td>
<td>9'04&quot;</td>
<td>9'04&quot;</td>
<td>9'04&quot;</td>
<td>9'04&quot;</td>
<td>9'04&quot;</td>
<td>9'04&quot;</td>
</tr>
</tbody>
</table>

**Channel Level**

<table>
<thead>
<tr>
<th>Front</th>
<th>[M1]</th>
<th>[M2]</th>
<th>[M3]</th>
<th>[M4]</th>
<th>[M5]</th>
<th>[M6]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
</tr>
<tr>
<td>Center</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
</tr>
<tr>
<td>Surround L</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
<td>-2.0dB</td>
</tr>
<tr>
<td>Sun Back L</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
</tr>
<tr>
<td>Sun Back R</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
</tr>
<tr>
<td>Sub Woofer</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
<td>+0.5dB</td>
</tr>
</tbody>
</table>

**Crossover frequency (kHz)**

- Front: 25kHz
- Center: 25kHz
- Surround L: 25kHz
- Sun Back L: 25kHz
- Sun Back R: 25kHz
- Sub Woofer: 25kHz

**X-Curve**

[Continue]
1 Menu bar and menu icons
You can choose the following commands from the application menus.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens a file that has been saved on the PC (see page 17).</td>
</tr>
<tr>
<td>Close</td>
<td>Closes a file.</td>
</tr>
<tr>
<td>Save</td>
<td>Save measurement data in a file (see page 16).</td>
</tr>
<tr>
<td>Save As</td>
<td>Receives measurement data (see page 9).</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the current individual graph.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays a preview screen to show how the printed page will appear.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the application.</td>
</tr>
</tbody>
</table>

- It is not possible to print or preview items that have not been received (items for which there is no data).

<table>
<thead>
<tr>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>The way in which the graphs are displayed can be changed.</td>
</tr>
<tr>
<td>Graph 2D</td>
<td>Displayed in two dimensions.</td>
</tr>
<tr>
<td>Graph 3D</td>
<td>Displayed in three dimensions.</td>
</tr>
<tr>
<td>The reverb characteristics graph display type can be changed.</td>
<td></td>
</tr>
<tr>
<td>Each Ch</td>
<td>All the channels are displayed individually.</td>
</tr>
<tr>
<td>The graph for the listening environment’s reverb characteristics (before calibration) is displayed</td>
<td></td>
</tr>
<tr>
<td>Pair Ch</td>
<td>Composite reverb characteristics for the left and right pairs of the “Front”, “Surround” and “Surr Back” channels are displayed. Use the “Pair Ch” mode to display the graphs for the reverb characteristics after calibration.</td>
</tr>
<tr>
<td>Demo</td>
<td>Displays 3D graphs with rotating.</td>
</tr>
</tbody>
</table>

- To finish, reselect and uncheck the box.
2 Display item selection tab
A graph for the reverberation frequency characteristics or the MCACC parameter list is displayed. The “Group Delay” function is not used on this receiver. Nothing is displayed if it is selected.

3 Level [dB]
The level axis.

4 Time [msec]
The time axis.

5 Channel memo (only available when the channels are displayed on the reverb characteristics graph)
Allows you to record a short memo about each channel.

6 Date and time
Display the date and time when the measurement data was transferred to the PC.

7 Channel and frequency switch buttons
Ch: Selects channel display mode (frequencies are displayed along graph depth axes).
Freq: Selects frequency display mode (channels are displayed along graph depth axes).

8 All/individual display switch menu
Allows you to select All display or individual display (Left, ALL, etc.).

9 Graph adjustment bar
Z: Increases or reduces the display unit of the Level [dB] scale.
M: Moves the Level [dB] scale.
E: Moves the viewpoint of 3D graphs vertically. (Cannot be changed for 2D graphs.)
R: Moves the viewpoint of 3D graphs horizontally. (Cannot be changed for 2D graphs.)
10 Bar Graph
Changes the type of graph display. The display switches between the band graph and bar graph by pressing this button.

11 File memo
Memos concerning the file (conditions at the time of measurement, etc.) can be stored for the different items.

12 Reverb type
Indicates whether the reverb characteristics are before calibration (EQ OFF) or after calibration (EQ ON). (For the reverb characteristics after calibration, the EQ calibration curve is displayed.)

13 Legend
Shows which colors in the graphs correspond to which channels or frequencies.

14 Freq [Hz]/Channel
In channel display mode, it becomes the frequency axis. In frequency display mode, it becomes the channel axis.

15 List display/individual display selector buttons
All the MCACC memories are displayed when “ALL MEMORY” is selected, individual MCACC memories are displayed when set for individual displays (“MEMORY1”, etc.).
Saving graphs in data files

You can save measurement data received from the receiver on your PC. Data received at one time is saved in one file.

1. **To save measure data, choose “Save” from the “File” menu.**
   
   If you have data that has already been saved and want to save it under a new name, choose “Save As”.

2. **Check the save location, assign a file name, then click “Save”.**
   
   The data is saved in a CSV format file (the file extension is “.csv”).

When you are finished saving data, you should (using the receiver controls) press “RETURN” to exit the Reverb Output PC screen. This takes the receiver out of transmission standby mode. (See page 67 (VSX-03TXH)/66 (VSX-01TXH, VSX-9130TXH) of the receiver’s Operating Instructions.)

**Note**

The CSV format file is often used to transfer data to applications such as databases and spreadsheets. You can use these applications to view the numeric values in your measurement data. However, if you use another application to edit the data and then save the file, the Advanced MCACC application may be unable to open the file.

Continue
Opening data files
You can open and display two or more data files to compare the data in the files.

1 Select “Open” from the “File” menu in the menu bar.

2 Select a file to display and click “Open”.
The previously saved measurement data is displayed.

Exiting the application

1 Select “Exit” from the “File” menu.
The application closes.
How to Interpret the Graphs

As indicated in Things you can accomplish with this application (page 3), the reverb characteristics graph can be used as reference when determining the calibration time position with the receiver’s “Advanced EQ Setup” function. It is also a valuable means for checking the effect of measures taken to improve the acoustics of the room.

How to interpret reverb graphs (Reverb)

The graphs show changes in microphone input level along a time axis, beginning from a state of quiet at time 0, when test tones begin to be output, and continuing while a constant level of sound is output from the speakers.

- If there is absolutely no reverberation in your room, the graph will look like figure A below.
- If there is reverberation, the graph will show a gradual accumulation of acoustic power, as shown in figure B.

![Figure A](image1.png)

![Figure B](image2.png)

Note

- Due to an effect known as “group delay”, lower frequencies may take longer to be generated than higher frequencies (this is most obvious when comparing the frequencies around 0 ms).
- If a graph extends beyond the display range, or almost fills it, you can change the display by using the Z (Zoom) control on the graph adjustment bar, adjusting the display range of the Level [dB] scale so that the whole graph is visible.
- Since channel level and speaker distance settings are displayed in the graphical output, it is best to make sure these settings (made in the Auto MCACC “ALL” or “Channel Level” setup) are adjusted properly before reverb measurement.
- Even in cases where there is a great difference in the output levels of different frequencies (the frequency characteristics of the room are poor), the frequency characteristics of individual channels can be set closer to flat using the “SYMMETRY” or “ALL CH ADJUST” calibration settings in the receiver’s “Auto MCACC” function. (For details, see page 39 (VSX-03TXH)/38 (VSX-01TXH, VSX-9130TXH) of the receiver’s Operating Instructions.)
- It is usually not possible to calculate the equalization values employed by the receiver’s Acoustic Cal EQ function simply by viewing the graphs displayed on your PC. (This is because the automatic adjustments made by Acoustic Cal EQ function take account of factors such as equalization band interference and analytical filter characteristics, to achieve the optimum characteristic profile.)
- There may be differences on the reverb characteristics graphs after measurements with the Auto MCACC function (“CUSTOM” → “ALL”, “Keep SP System” or “EQ Pro. & S-Wave”) as compared to after measurements with the Reverb Measurement function (Manual MCACC → “EQ Professional”) due to the standing wave control setting. With Auto MCACC, the reverberations are measured with standing wave controlled, so the reverb characteristics graph does not reflect the influence of the standing waves. By contrast, with Reverb Measurement, the reverberations are measured without standing wave control, so you can check the reverb characteristics including the influence of the standing waves. If you want to check the acoustics of the room (with the standing waves), we recommend using Reverb Measurement.

Continue
Deciding the time period for Advanced EQ Setup calibration

With conventional MCACC EQ calibration, the microphone input's data acquisition time was fixed at between 80 and 160 [ms] (red part of Figure 1). By contrast, with the receiver's Advanced EQ Setup function allowing more professional equalization, the customer can select individual points between 0 and 80 [ms] (with a 20 ms width) (blue part of Figure 1).

You can specify the time period setting using the “Advanced EQ Setup” in the “EQ Professional” sub-menu (in the “Manual MCACC” menu). This setting is not required if you’re satisfied with the results of the “Auto MCACC” setup (For details, see page 46 (VSX-03TXH)/45 (VSX-01TXH, VSX-9130TXH) of the receiver’s Operating Instructions).

Note

You can specify the time period setting using the “Advanced EQ Setup” in the “EQ Professional” sub-menu (in the “Manual MCACC” menu). This setting is not required if you’re satisfied with the results of the “Auto MCACC” setup (For details, see page 46 (VSX-03TXH)/45 (VSX-01TXH, VSX-9130TXH) of the receiver’s Operating Instructions).

<table>
<thead>
<tr>
<th>Time period point to be selected</th>
<th>Level (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acoustic Cal EQ professional calibration range (selectable points)</td>
<td>243</td>
</tr>
<tr>
<td>Conventional MCACC EQ calibration time range (fixed)</td>
<td>121</td>
</tr>
</tbody>
</table>

To decide the time period for Advanced EQ Setup calibration, view the graphs of the measured reverb characteristics, and refer to the following three patterns.

Pattern 1: Different reverb characteristics for high and low frequencies

In rooms with reverb characteristics like those shown in Figure 2, lower frequencies often seem overly reverberant compared to higher frequencies (i.e. the room sounds ‘boomy’). With conventional MCACC EQ calibration, data between 80 and 160 [ms] (red part of Figure 2) was acquired, so the low frequency volume was deemed high and the high frequency volume deemed low, and the equalization curve was calibrated with the high frequencies somewhat boosted. However, for the characteristics of the sound reaching the ear directly within about 40 ms, there is enough volume that there is no real need to boost the high frequencies, so with equalization using the conventional MCACC EQ calibration the high frequencies sometimes sounded too strong. Therefore, the Acoustic Cal EQ may result in a room where high frequencies sound shrill. In cases like this, setting the time period for Advanced EQ Setup to 30 to 50 msec (the blue area in Figure 2) to adjust for sounds coming directly from the speakers can flatten the frequency response for direct sounds (including initial reflections) and give a better-balanced sound field.

Figure 1 Comparison of microphone data acquisition time periods

Figure 2
Pattern 2: Different reverb characteristics for different channels
If the reverb characteristics differ for the different channels as shown in Figure 3, equalization using the conventional Acoustic Cal EQ acquired data between 80 and 160 [ms] (red part of Figure 3), so equalization was performed to gradually equalize the tone of the different channels for 80 ms from the time the sound was emitted from the speakers and after (it was not possible to equalize the response of the direct sound). However, the sense of placement and movement of the acoustic image and the unity of the sound from the different speakers is influenced not by the reverberations but by the direct sound from the speakers (including the early reflected sound). In cases like this, you should use Advanced EQ Setup and set the time period to 30 to 50 msec (the blue area in Figure 3). This allows the characteristics of direct sounds to be balanced for each channel, giving an ideal sound field with good acoustic positioning and movement.

Pattern 3: Similar reverb characteristics for high and low frequencies and all channels
As shown in Figure 4, when the reverb characteristics for all channels are similar across all frequencies, your sound experience will probably not be adversely affected by reverberation. We recommend calibrating with a time of about 60 to 80 [ms] (green part of Figure 4) specified at Advanced EQ Setup. This produces a total calibration for both direct sounds and reverberations, resulting in an ideal sound field.

Note
- If you are not sure which time period to specify in Advanced EQ Setup, start by trying 30 to 50 msec. If the graphs show an unusual reverb curve for a specific frequency, the cause may be some accidental variation. Instead of selecting 30 to 50 msec, try another time period.
- Another good method is to try various time periods in Advanced EQ Setup and select the one which sounds the best.
- Time period settings cannot be made on the PC. They can only be made on the on-screen display of the receiver, using the receiver’s Advanced EQ Setup function.
How to Interpret the Graphs (Continued)

Checking steps to improve your room’s reverb characteristics

The reverb characteristics of your listening room graphs are evident from the graphs. For your reference, the following four examples explain how different types of rooms appear in the graphs.

Case 1: Graph rises to right across all frequencies

This is probably a room with a good deal of reverberation. If possible, we recommend that you try installing some sound absorbent material to create a drier acoustic space according to your preference.

Case 2: Specific channel shows unusual reverb characteristics

There is probably some object near the speaker which affects sound reproduction. If possible, we recommend that you try to reduce the influence of that object.

Continue
Case 3: Specific frequency shows unusual reverb characteristics

There is probably something in the room that affects the reproduction of that frequency. If possible, try to find an arrangement that reduces the effect.

Case 4: A specific channel is slow to start

This can happen when a speaker is unstable. If possible, we recommend that you try to stabilize the speaker stand, to bring the characteristics of that channel into line with the other channels.

**Note**

In all of these cases, when the “Auto MCACC” operation is performed, the calibration time position is selected automatically in consideration of the room’s characteristics so that the optimum sound field can be achieved. (See pages 10 and 39 (VSX-03TXH)/38 (VSX-01TXH, VSX-9130TXH) of the receiver’s Operating Instructions.)

When measurements are made with the “CUSTOM” mode, automatic calibration taking the reverberations into consideration is only performed when “ALL”, “Keep SP System” or “EQ Pro. & S-Wave” is selected at “Custom Menu”.

Continue
Displaying reverb characteristics after calibration

To display the graph of your listening area's reverb characteristics with the equalization performed by this receiver (after calibration), you'll need to select the “EQ ON” option from the “Reverb Measurement” menu. Using this graph, you can confirm the effects of MCACC calibration for your listening area.

1 Connect the receiver to your PC with a RS-232C cable.
   See page 7 for more on connecting the RS-232C cable.

2 Select the “EQ Professional” option for “Manual MCACC”, and perform with “Reverb Measurement” set to “EQ OFF”.
   (See page 8 or page 46 (VSX-03TXH)/45 (VSX-01TXH, VSX-9130TXH) of the receiver’s Operating Instructions.)
   The reverb characteristics before equalization are measured.
   If the “Auto MCACC” operation has never been performed, conduct the “Auto MCACC (ALL)” operation here.
   (See page 10 of the receiver’s Operating Instructions.)

3 Receive and save the data by selecting “Output PC” from “Data Management”.
   When you receive and save this information on your PC, you will be able to see the graph of your listening area’s reverb characteristics before calibration.

4 Select “Reverb Measurement” from the receiver’s “EQ Professional” menu and choose the “EQ ON”.
   (See page 8 or page 46 (VSX-03TXH)/45 (VSX-01TXH, VSX-9130TXH) of the receiver’s Operating Instructions.)
   Measure the room’s reverb characteristics after equalization with the microphone at the same position as when the “Auto MCACC (ALL)” operation was performed. The measurements are performed with the EQ values stored in the MCACC memory selected on the receiver, so before measuring the reverb characteristics, select the MCACC memory to be measured after equalization.
5 Receive and save the data by selecting “Output PC” from “Data Management”.

When you receive and save this information on your PC, you will be able to see the graph of your listening area’s reverb characteristics with the equalization performed by this receiver (after calibration). The following graph shows the reverb measurement results after Advanced EQ Setup calibration (with a time period setting of 30-50ms):

![Graph of reverb characteristics](image)

**About the types of displays of the graph for the reverb characteristics after EQ calibration**

**For “SYMMETRY” or “FRONT ALIGN”**
- The display type is set to “Pair Ch” (page 13). For reasons of the properties of the different EQ curves, when the “Each Ch” display type is set, the reverb characteristics for the different channels do not line up properly.
- The reverb characteristics prior to calibration are displayed in the “Each Ch” mode, so if you want to compare the characteristics before and after calibration, set the display type prior to calibration to “Pair Ch”. This way the number of channels before and after calibration are the same, allowing you to compare.

**For “ALL CH ADJUST”**
- The display type is set to “Each Ch” (page 13). For reasons of the properties of the EQ curves, when the “Pair Ch” display type is set, the reverb characteristics for the different pairs of channels do not line up properly.
- Since the “Each Ch” display type is set both before and after calibration, the graphs can be compared as such.

**Note**
- “Reverb Measurement” calibration data will be lost if the power is switched off.
- The graphs displaying reverb measurements both before and after calibration are displayed in 2-D for comparison purposes.
**Display of the MCACC parameters**

In addition to the reverberation frequency characteristics data measured with the Advanced MCACC function, all the parameters (results of measurements) set in the MCACC memories can be checked on the computer.

**Parameters that can be displayed**

1. Speaker Setting (Speaker system and crossover frequency)
2. Channel Level (Speaker output level)
3. Speaker Distance (Distance to the speaker)
4. Standing Wave Control (Standing wave control filter)
5. Acoustic Cal EQ (Calibration of the listening environment’s frequency characteristics)\(^a\)
6. X-Curve (Tonal balance of the speaker system for movie soundtracks)

\(^a\) In addition to the EQ calibration values stored in each MCACC memory, the EQ calibration curve name (“Symmetry”, “All Ch Adjust” or “Front Align”) is also displayed. Furthermore, “Custom” is displayed for memories for which the equalizer has been adjusted manually. Measurements of the reverb characteristics after calibration (page 23) are performed applying the EQ calibration curves for these memories.

**Displays of the different memories**

It is possible to receive and display the data for all the MCACC memories (MEMORY1 to MEMORY6), but also possible to display the data for the individual memories.

![MCACC Parameter Display](image)

**Note**

When there are items that cannot fit on the display, move the scroll bar on the screen to display the remaining data.
Updating, Deleting and Repairing the Application

Updating the application
A new installer is made available on the download site whenever the Advanced MCACC application is updated. You can download the new installer and use it to overwrite (update) the application on your PC.

**Note**
To check the version of your application, choose "Help" → "Version Info" from the menu bar. A window showing the version (Version 2.1, etc.) appears.

1. **Double click the new downloaded installer**.
   The InstallShield Wizard appears. Perform steps 2 to 5 of Installing the Application (page 4).

2. **Select “Install”**.
   Proceed to step 3 if “Ver. 1.1” or “Ver. 1.4” of the application is installed on your computer, to step 5 if “Ver. 2.0” or later is installed.
3 Select “Yes”.
The previously installed application is deleted.

4 Select “OK”.
Installation of the latest version begins.

5 Click “Finish”.

This completes the updating of the application.

Note
The application may not operate properly if two versions of it are installed on the same computer. If you wish to return to a previous version of the application, uninstall (delete) the currently installed version first, then reinstall the previous version.
Deleting the application
You can use either of the following methods to uninstall (delete) the application from your PC.

**Method 1: Delete from the Control Panel of the PC**
From the Start menu, click “Setting” → “Control Panel” → “Add/Remove Programs”.

**Method 2: Use the installer file for the currently installed version to delete the application**

**Note**
The application cannot be deleted by launching the installer file of a version different from the installed version. To do so, launch the installer file for the same version.

1. Double click the “PioneerAdvancedMCACC_e_ver_*_*.exe” file.
The InstallShield Wizard appears.

2. Select “Next”.

3. Select “Remove”, then select “Next”.

![InstallShield Wizard](image.png)
4 Select “Remove”.

5 Click “Finish”.

This completes the deletion of the application.
Repairing the application
The repair function can be used for example if desktop shortcuts have been deleted, etc., to restore the application to the same conditions as when it was first installed.

Note
The application cannot be repaired by launching the installer file of a version different from the installed version. To do so, launch the installer file for the same version.

1 Double-click the installer file for the currently installed version.
The InstallShield Wizard appears.

2 Select “Next”.

3 Select “Repair”, then select “Next”.

![Program Maintenance Wizard](image)

Continue
Updating, Deleting and Repairing the Application (Continued)

4 Select “Install”.

5 Click “Finish”.

This completes the repairing of the application.

Modifying the application
With the application for the VSX-03TXH, VSX-01TXH or VSX-9130TXH, “Modify” cannot be used.
Troubleshooting

As you use the Advanced MCACC application, errors can occur for a variety of reasons, such as incompatibilities with other applications and the current configuration of your PC. If an error occurs, refer to the troubleshooting points below. If the trouble cannot be rectified even after checking the points listed below, ask the Pioneer Customer Support Division (USA) or Customer Satisfaction Department (Canada).

Pioneer Electronics Service Inc.  TEL: 800-421-1404
Pioneer Electronics of Canada, Inc.  TEL: 1-877-283-5901

The application is unstable, or does not work normally

Cause 1:
If your PC does not meet the requirements for using this application, the application can be unstable, very slow, or freeze up.
Check to be sure that your PC meets the requirements for using this application. (See page 2.) You cannot use this application unless your PC meets all of the requirements.

Cause 2:
Even if the required conditions for the computer environment are met, if many files are opened in the application and all are displayed with the MCACC Para option, an error message may appear due to lack of computer memory.
If the error below should occur, either close some of the opened files, or quit the application itself then restart it. If you want to compare many files, we recommend printing them out using the Print function and comparing them on paper.
Troubleshooting (Continued)

**Advanced MCACC cannot be installed**

**Cause 1:**
An error message may appear if there are not enough system resources available.
If an error message like the one shown below appears, re-start the PC, then start the installer (PioneerAdvancedMCACC_e_ver_*_.exe) with no other applications active.

![Error message](image)

**Cause 2:**
Installation of Advanced MCACC may fail because of incompatibilities with other applications.
Try the following, in the order indicated.
1) If there are any other applications active, exit the other applications and try starting the installer (PioneerAdvancedMCACC_e_ver_*_.exe) again.
2) If that does not work, try restarting your PC, and starting the installer (PioneerAdvancedMCACC_e_ver_*_.exe) with no other applications active.

**Cannot send measurement data to PC**

**Cause 1:**
Random transmission errors sometimes occur.
Even if an error occurred on your first attempt, try sending the data again. Sometimes the transmission succeeds when you try again.

**Cause 2:**
Messages like the following may appear if a transmission error occurs.

![Error messages](image)
Troubleshooting (Continued)

Try the following, in the order indicated.
1) In the setup screen of the receiver, check that “Start the MCACC application on your PC” is displayed.
   (This message indicates that the receiver is ready to send data to the PC.)
2) Check that the RS-232C cable is properly connected. (Be sure to switch off all components and disconnect their power cord from the power outlets before changing any cable connections.)
3) Exit any other active applications.
4) Check the COM port number.
5) Check the type of RS-232C cable to use is correct (page 7).
6) Restart the Advanced MCACC application.
7) Restart your PC.

Cause 3:
The following message may appear and the data transmission may be not available.

![Advanced MCACC](image)

Refer to the operation manual for PC or the application software using the COM port, and make the connecting COM port available for transmission.

Advanced MCACC cannot be updated

Cause 1:
An error message may appear if there are not enough system resources available.

If an error message appears (like the one explained above in Cause 1) of Advanced MCACC cannot be installed (page 33), restart your PC and start the installer (PioneerAdvancedMCACC_e_ver_**.exe) with no other applications active.

Cause 2:
Updating of Advanced MCACC may fail because of incompatibilities with other applications.

Try the following, in the order indicated.
1) If there are any other applications active, exit the other applications and try starting the installer (PioneerAdvancedMCACC_e_ver_**.exe) again.
2) If that does not work, try restarting your PC, and starting the installer (PioneerAdvancedMCACC_e_ver_**.exe) with no other applications active.

Continue
Troubleshooting (Continued)

Reverb characteristics graph cannot be printed

Cause:
It is not possible to print reverb characteristics graphs displayed in the “ALL” mode.

Print after selecting an individual channel or frequency graph.

Some functions in application operation cannot be used

Cause:
You may not properly use the application software not corresponding to your receiver.
Check the model number of your receiver and use the application software corresponding to it.

The receiver causes a malfunction when it is connected to the PC with a RS-232C cable

Cause:
When the receiver is connected to your PC with a RS-232C cable, the power of the receiver may be automatically switched on when you operate the PC.
Unplug the cable when not in use.
Troubleshooting (Continued)

**EQ response in the graph (following calibration) does not appear flat**

**Cause 1:**

The slope of the graph indicates the reverb characteristics. The reverb characteristics of the room itself cannot be corrected by equalization alone, so the angle of the graphs’ slope is the same before and after calibration.

Through calibration, the graphs for the different frequencies move horizontally by the amount of the equalization. For the results of calibration, you can check that the graphs line up at a specific point on the time axis.

The reverb characteristics themselves (the shape of the graph) do not change unless the listening environment is improved.

(See pages 18 to 20.)

**Cause 2:**

For various reasons, the frequency characteristic graphs may not become flat even when equalization is performed with the “SYMMETRY” or “ALL CH ADJUST” functions.

With MCACC, calibration is performed automatically to achieve the optimum sound quality, but without any unreasonable calibration.

**Adjustments made with the “Manual MCACC” setup do not change the graph**

**Cause:**

Despite level adjustments being made, the filters used for analysis may not display these adjustments in the graphical output.

However, these adjustments are taken into account by the filters dedicated to overall system calibration.

**Lower frequencies do not seem to have been calibrated for SMALL speakers**

**Cause:**

Low frequency calibration with the equalizer is not performed for speakers that are set to “SMALL”, but the reverb characteristics display shows the pure characteristics of the sound output from the speakers, so it indicates the characteristics with no low frequency calibration.

With MCACC, optimum calibration is performed in function of the speakers’ sound reproduction capacities, so there is no problem for low frequency calibration of speakers that are set to “SMALL”.

